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1. Why it’s important to “copy” the printed book when writ-
ing 

 
Modern word processing programmes allow for the “simulation” of the 

printed book. The benefits to an author capable of using this are obvious: 
• while writing, the clearer your vision of how the printed page will look, the 

better you can adapt it to suit your target readership and your ideal book 
form; 

• you can use useful editing styles; you can use bold or italics to highlight 
words or key points; you can change the body size and font; you can illus-
trate plans and concepts etc.; 

• above all, you can work directly on the file which will be used for printing 
and so you can make modifications right up to the last minute. 
Here, we provide base instructions for those of you who have yet to write 

and format your work and for those who have already written it but still need to 
arrange and format it. If you have written your work, we advise you to copy and 
paste the entire text because Word often keeps many of its default formats 
which you might need to correct. 
 

 
2. Volume size and page setup  

 
The format of FrancoAngeli  books and magazines, once set, is standard: 

height 23cm; width 15.5cm. (Some series use a 21x29.7cm format. This won’t 
be covered here). 

 
The page setup on the computer should be set to the following: 

• top margin 5cm; bottom 6.2cm; left 4.6cm, right 4.6cm;  
• header 0cm; 
• footer 5.2cm; 
• gutter 0cm. 
  
It is, however, essential that the computer is programmed to print on A4 pa-
per (21x29.7cm). To select A4 in Word, go to “File-Page Setup-Size”. 

Text set up in this way will be 11.8cm wide and 18.5cm high. 
The page number will be placed 0.8cm from the foot of the last line. To in-

sert the page number in Word go to “Insert-Page number”. The page number 
should be set, as we’ll explain later, as 10 point Times New Roman italic.  
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3. Characters, type size and line spacing  
 
We suggest the following fonts and formats: 
  

• chapter heading: 16 point Times New Roman (I) – single line spacing – 
left justified – never precede it with the word “chapter”: it’s not necessary! 
The distance between the heading, on a single line, and the text or para-
graph title is 10 spaces in 12 point. If the heading takes up more than one 
line or if the name of the chapter author is included (see below) the num-
ber of spaces will be reduced accordingly. In so doing the text or para-
graph title will fall to about 6cm from the top border of the text area (in 
this case it helps to use the ruler which appears on the left hand side of the 
screen); 
 

• authors of single chapters: 12 point Times New Roman italic – single 
line spacing – left justified. The name and surname should be positioned 
under the chapter heading, separated from the heading by a blank line and 
preceded by the word “by” in lower case (eg. “by Giorgio Rossi”); 
 

• paragraph headings: 12 point Times New Roman bold (B) – single line 
spacing – left justified. 
Leave 2 blank lines before the paragraph heading and a blank line after it. If 
the heading comes at the end of a page, push it onto the next page by  insert-
ing more blank lines (usually one or two are sufficient). Alternatively (and 
this would be better), set the heading to stay with the successive paragraph 
(“Format-Paragraph-Keep with Next”); 
 

• subparagraph headings: 12 point Times New Roman bold italic (B and I) 
– single line spacing – left justified; for the formatting see above (“para-
graph headings”); 
 

• sub-subparagraph headings: 12 point Times New Roman italic (I) – sin-
gle line spacing – left justified; for the formatting see above (“paragraph 
headings”); 
 

• sub- sub-subparagraph headings: 12 point Times New Roman – single 
line spacing – left justified; for the formatting see above (“paragraph head-
ings”); 
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• text:  
- up to 144-160 printed pages: if the volume does not go beyond 144-

160 printed pages it can be formatted in 12 point Times New Roman 
with single line spacing; 

- from 144-160 printed pages: 11 point Times New Roman with 13 
point line spacing. If necessary, it is possible to format with single line 
spacing to recuperate pages. 

Only in exceptional cases should you use 10 point Times New Roman for 
volumes that exceed 400-500 pages (with 12 point line spacing).  
Attention: the text should be justified and the first line of every paragraph 
indented 5mm (to set the indent in Word, click “Format-Paragraph-
Special-First Line-Indent”); 
 

• quotations: if you are formatting as a block separate from the main text, 
use 10 point Times New Roman with 12 point line spacing, leaving one 
blank line before the beginning of the quote and one blank line after it, 
without opening and closing quotation marks. If you are inserting in the 
text, leave the quotation in 11 point and place it between angle quotes  (eg. 
«....») (you’ll find angle quotes in “Insert Symbol”). 
Attention: if the quotation begins with a capital letter it should be justified 
and the first line of the paragraph indented 5mm; if it begins with a lower 
case letter it should be justified but the first line remains flush left; 

 
• footnotes: 9 point Times New Roman, single line spacing. Attention: the 

notes should be justified and the first line of every paragraph should be in-
dented 5mm; 

 
• tables, text in images: as a rule, 9 point Times New Roman, single line 

spacing. In graphics, larger or smaller type sizes can be used to highlight 
single words or when it’s necessary to stay within the width of the page. 
Leave a blank line both before and after the table or image; 

 
• image or table captions: in 9 point Times New Roman italic, single line 

spacing, justified. Attention: an image caption goes under the image, while 
a table caption goes above the table;  

 
• highlighted sentences (boxed or not): these can be formatted in the same 

type size and line spacing as the main text, in italics or bold, according to the 
highlight that you want to give them. They can also be boxed with a light 
grey background. Attention: even highlighted sentences need to be justified 
and the first line of every paragraph indented 5mm; 
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• appendices, glossary, bibliography: as a rule, 10 point Times New Roman 
with 12 point line spacing. In general, 9 point type size is not recommended, 
unless one is dealing with text for simple consultation and one wants to limit 
the number of pages. It should, however, be used for the bibliography.  
The appendices and glossary should be justified and the first line of 
every paragraph indented 5mm.  
The bibliography should be justified but the first line should be flush left 
and successive lines indented 5mm; 

 
• page numbers: centred at the bottom of the page in 10 point italic. 

 
A page in Times New Roman contains: 

 in 11 point with single line spacing: c.2730 characters (including spaces); 
    in 11 point with 13 point line spacing: c.2650 characters (including spaces); 
 in 12 point with single line spacing: c.2325 characters (including spaces). 

 
 

4. Page numbering  
 
 The first four pages of the book will be handled by the editorial staff; page 
1 usually has a presentation of the series, page 2 is generally blank, page 3 is 
usually the title page, and on page 4 there’s the copyright. 
 Therefore, the first page you have to number is page 5. Pages follow ac-
cording to the following criteria: 
• index: on page 5 and following pages; 
• presentation, premise, introduction: these should appear on odd-numbered 

pages (leave a blank page if necessary);  
• section headings: these should appear on odd-numbered pages; 
• first chapter (or first chapter within a section): this should appear on an 

odd-numbered page; 
• subsequent chapters: as they fall, either on even- or odd-numbered pages; 
• conclusions: these should appear on an odd-numbered page; 
• bibliography: this should appear on an odd-numbered page. 
 
 
5. How to format the index 
 

If you are used to working with Word styles, you can use these to format the index 
quicker. Otherwise, we suggest that you format the index using a table template (see 
the index facsimile on the following page - the bold entries should be deleted!).  
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6. Hyphenation 
 

Always use automatic hyphenation of the text (in Word, “Tools-
Language-Hyphenation-Automatically Hyphenate Document”).  

Attention for the foreign words: the hyphenation might be wrong. 
 
 

7. Automatic spell check 
 
We recommend deactivating the automatic spell check. The risk is that 

surnames are corrected without you even noticing (for example, “Mondadori” 
becomes “Montatori”). If you can, however, run a complete spell check at the 
end.  

 
 
 

8. Blank lines and spaces 
 
Blank lines between periods: never leave a blank line between para-

graphs unless you want to separate a part of the text from the text which pre-
cedes it.  

 
Widow lines and orphan lines: these refer to the first or last line of a 

paragraph when (in the former’s case) a single line remains at the bottom of a 
page, or (in the latter’s case) a single line sits at the top of a new page.  

Programmes generally correct these anomalies automatically. However, 
we recommend that you deactivate the automatic setting (in Word “Format-
Paragraph-Line and Page Breaks-Widow/Orphan Control”: click off the 
“tick”) and intervene manually by pressing the return key when necessary 
(usually once) to elongate the text by a line or by deleting a return to reduce it 
by a line. Only in this way will you avoid leaving blank lines at the end of the 
page.  

 
Blank spaces at the beginning of the page: always eliminate them. 
 
Spaces between words: always leave just 1 blank space between words.    

For safety’s sake, we recommend that you do an automatic search (look for 
“two blank spaces” and replace them with “one blank space”) as often as is 
necessary to obtain a research result “0”. 
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Spaces before and after punctuation marks: always leave a blank space 
after (and not before) a punctuation mark (for example, always leave a space 
after a comma or full stop, and never before one). Never leave a space after an 
apostrophe.  

 
 

9. Notes 
 

As a rule, notes go at the bottom of the page. Attention: don’t insert the 
notes manually, but insert them with the programme you are using (in Word: 
“Insert-Reference-Footnote”) in such a way that the programme automatically 
numbers them.  

The numbering of the notes will recommence from 1 in each new chapter. 
To get the numbering to recommence, give the instruction to break the section 
before each chapter and format the notes in such a way that the numbering 
begins from 1 in each section throughout the document.   

The note’s reference number goes in the text in 8 point superscript, with-
out brackets, and before the punctuation mark. 

The note’s text appears in 9 point with single line spacing.  
The reference number that appears at the bottom of the page should auto-

matically appear in 8 point superscript. The note’s text will follow on.  
Attention: delete the line that separates the text from the notes. 
Attention: never leave a blank line between notes. Deactivate the 

widow/orphan control in the notes as well.  
Attention: there are two types of notes: bibliographical notes and those 

that expand on a subject. Bibliographical notes contain the bibliographical de-
tails of the author quoted. If you decide to use this type of note, don’t give the 
bibliographical information in the text (see par.17) as well, just give it in the 
note. And viceversa.  

 
 

10. Use of capital letters and capitals of formal address 
 

 Don’t write chapter or paragraph headings in capital letters.   
 Only use capital letters for words in the text in exceptional cases: except 

for isolated cases where you have a particular reason for highlighting some-
thing in capitals, it’s preferable to highlight with bold or italics. 

Avoid as much as possible the use of capital letters of formal address. The 
use of an initial capital can lead to mistakes (the same term can be written with an 
initial capital or in lowercase and the inconsistency is often difficult to spot).  
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Therefore, it’s always preferable to type common words (eg. human re-
sources, management, company) in lowercase, and use capital letters only for 
“Country”, “Republic” (when referring to the Italian Republic), “State”, for the 
names of specific offices and departments (eg. Administrative Management, 
Shipping Office, Personnel Management etc.), and for common terms used as 
part of proper names (eg Bank of Naples). Preferably limit your use of capital 
letters to when you want to highlight a term in a particular and justifiable way 
(eg. the Truth). 
• Qualifications/titles: always in lowercase (eg. doctor, president and not 

Doctor, President). 
• Subject names: always in lowercase ( eg. philosophy and not Philosophy). 
• Company or State initials: always without full stops when the acronym is 

formed by single letters followed by full stops (eg. not U.S.A. but USA). 
Leave the full stop when it is followed by more than one letter (eg. 
Co.Re.Co). 

• Programme initials: use capital letters or small capitals: eg. IHIRMS o 
IHIRMS. 

• Psychology initials: generally leave them in capital letters (eg. DSM); 
In any case, it is essential that a uniform criterion is applied throughout 

the text. 
 
 
11. Foreign words 

 
These should be typed in italics only if they have an exact equivalent in 

Italian. In this case the grammar rules of the original language should be re-
spected.  

The “technical” terms in current usage among the target readership (or 
those who are set to become target readers) should, however, appear in Ro-
man type and remain unchanged in the plural. 

 
 

12. En dash versus hyphen 
 
En dash (–): if you want to insert a parenthesis into a sentence, remember 

that you must use a medium-length dash (–) to open and close the parenthesis 
(you’ll find them in “Insert-Symbol”). 

Hyphen (-): a short dash (-) is only used to join two words.  
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13. Itemised lists  
 
 Lists can be organised by numbers, letters or graphic symbols (•, , , 
etc.). 
 The first line of every list item should be set flush left, while successive 
lines should be inset 0.5 or 1cm, in such a way as to ensure that the first letter 
of each line is aligned. Attention: if the list is preceded by a sentence that fin-
ishes with a colon, use lowercase for the first word of each list item (as long 
as it’s not a proper name) and a semi-colon at the end of the item. If, however, 
the sentence preceding the list finishes with a full stop, use a capital letter for 
the first word and a full stop after the last word.  

 
 

14. Apostrophes and quotation marks 
 

Always use an apostrophe with a serif (’) and not a sans-serif straight apos-
trophe ('). Similarly, always use curly quotation marks with serifs (“ ”) and not 
straight sans-serif quotation marks (").  

Use curly quotes (“ ”) if you want to “highlight” a word; however, use «an-
gle quotes» (« ») to open and close the quotation in the text. If a second quote is 
included within a quote already marked by angle quotes, it should be indicated 
with curly quotes.  

 
 

15. Decimals: comma or point? 
 

It would be more elegant to use a point for decimals, as per the rules of 
English grammar. However, if your work has been formatted with commas, 
you should at least check that they have been used consistently.      
 
 
16. Bibliographical references  
 

Bibliographical references inserted directly in the text should include the 
surname of the author followed by a space and then the year of publication of 
the work in its original language in round brackets – “Freud (1899) said 
that...”. Alternatively, the author’s surname should go in brackets followed by 
a comma, space and year of publication – (Freud, 1899).  

If you want to cite the page number, this should be indicated in brackets in 
the text, preceded by a “p.” after the year and comma, and not in the bibliog-
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raphy at the end of the article. If the page number refers to the original edition 
and not to the Italian translation listed in the final bibliography, you’ll need to 
add “orig. ed.” (Loewald, 1980, p. 56 orig. ed.); if the final bibliography con-
tains references to further translations, you must specify the year of the trans-
lation to which you are referring (Loewald, 1960, p. 97 it. trans. 1994).  

If there are various publications by the same author in the same year, these 
should be indicated by placing after the year lowercase letters in alphabetical 
order. If there are various references to the same author with page numbers in 
the brackets, commas should be used to separate them and not to separate the 
year from the respective page; it’s preferable to use a semi-colon to separate 
different authors within the same brackets. 

If there are two authors, their names should both be written and connected 
by “and”, which can also be used to connect the last two of a list of three au-
thors. If there are more than three authors, you should write the surname of 
the first author followed by  et al. (italics, from the Latin et alii). The follow-
ing are possible examples: 

 
-  Freud (1899) said that...  
-  According to dream theory (Freud, 1899)...  
-  The principles of cognitive therapy (Beck et al., 1979) establish that...  
-  Quoting Kernberg (1981, p. 35), he says that...  
-  Eissler (1953) writes that «every parametric introduction introduces the risk that 

resistance is temporarily eliminated before it has been adequately analysed» (p. 
65).  

 
Bibliographical references at the end of the text should be listed without 

numbering, in alphabetic order according to the authors’ surnames, and, for   
each author, the works listed should be in chronological order according to the 
date of publication (works by the same author published in the same year are 
indicated by  a, b, c next to the year of publication).  

In the case of analogous surnames (for example Melanie Klein and George 
S. Klein), you should order them according to the initial letter of the first name; 
if the surname and first letter of the first name are the same, the first names 
should be written out in full  (and if possible include the middle initial for     
further clarity – even more importantly, this rule should be applied in the text, 
above all if there are authors who share the same first name initial, for example 
Daniel N. Stern and Donnel B. Stern).  

The year goes in brackets straight after the surname and the initial of the first 
name followed by a full stop, thus: “Freud S. (1910)”. If the author has two 
Christian names (that is if there is also a middle initial), as is common in Anglo-
Saxon countries, you should write the two initials without a space between them 
(for example: Bianchi G.A., Rossi P.F., Kernberg O.F., etc.).  
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In the case of works written by several authors, you should include the 
surnames of all the authors. In the case of a work edited by an author or      
authors, all names should be listed followed by the expression  “edited by” for 
editions in Italian, and “eds.” or “ed.” for editions in a foreign language. 

If the year of publication is different from that of the original, it should go 
after the name of the publisher and be preceded by a comma, otherwise it is 
sufficient to put the year in brackets at the beginning of the bibliographical 
item after the name of the author. 

Bibliographical references should therefore be set out according to the rules 
deducible from the following examples: 
 
Volume: 
Beck A.T., Rush A.J., Shaw B.F. and Emery G. (1979), Cognitive Therapy of Depres-

sion, Guilford Press, New York (it. trans: Terapia cognitiva della depressione, 
Boringhieri, Torino, 1987).  

 
Edited, one author: 
Merini A., edited by (1977), Psichiatria nel territorio, Feltrinelli, Milano.  
 
Edited, several authors: 
Boltanski L., Claverie E., Offenstadt N. and Van Damme S., eds. (2007), Affaires, 

scandales et grandes causes. De Socrate à Pinochet, Stock, Paris. 
 
Essay taken from an edited work: 
Liotti G. (1985), Un modello cognitivo-comportamentale dell’agorafobia, in Guidano 

V.F. e Reda M.A., edited by, Cognitivismo e psicoterapia, FrancoAngeli, Milano.  
Beebe B. (1983), Mother-infant mutual influence and precursors of self and object 

representation, in Masling J., ed., Empirical Studies of Psychoanalytic Theories. 
Vol. 2, Analytic Press, Hillsdale, NJ.  

 
Magazine article: 
Minguzzi G.F. (1986), “È possibile valutare i risultati della psicoterapia?”, Giornale 

Italiano di Psicologia, 13, 1: 7-13.  
 
Unpublished text: 
Benedetti G. (1988), “Contribution to the debate on a speech by John Gunderson at 

the International Conference New Trends in Schizophrenia”, Bologna, 14-17 April 
(tape recording).  

 
Volume or  article from an Internet website: 

The same rules apply as for printed volumes and articles, with the addition of text 
available at the website: http://www... and the date of consultation.  
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In all these cases pay attention, if possible, to the rules concerning the use 
of capital letters in the titles of works in English. For example, titles in Eng-
lish use capital letters in all words except for a, an, the, and conjugations and 
prepositions up to four letters.  
 
 
17. Figures, graphs, drawings and photographs 
 

All figures should be numbered, progressively starting from 1 in each 
chapter.  

Both in the text and captions it’s standard to use the abbreviation  “fig.”. 
(Example caption: Fig. 1 - Figure caption). Remember that a figure caption goes 
beneath the figure.  
 All figures are printed in black and white (unless you have made a prior 
arrangement with the editorial staff).  Don’t therefore use colours to create 
new figures. If you have to use colour images save them with the grey scale.   

If you use figures (drawings, renderings, etc.) that you have acquired with  
a scanner or created digitally as a JPG or TIF, check that they have a resolu-
tion of 300 dpi before inserting them in the Word document.  

Attention: the reproduction of images must be authorised by whoever 
holds the rights (photographer, museum, archive, etc.). Images downloaded 
from the internet should not be considered free of copyright. And in any case 
remember that the resolution with which they are saved does not allow for 
their reproduction.  

Attention: the image must not exceed a height of 18.5cm and a width of 
11.8cm (unless you have made a prior arrangement with the editorial staff). If 
the image doesn’t fill the entire width of the page, centralise it.   
 
 
17.1. Graphs 

 
To create a new graph: “Insert-Picture-Chart”. 

 To modify an existing graph in Word: to modify the dimensions, posi-
tion and layout of the text in respect to the graph, click on the graph with right 
key of the mouse and select the option that you need. 
 
 
17.2. Drawings 
 

To insert a new drawing, select “Object” from the “Insert” menu and then 
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click on “Create New”. In the list of “Object Type”, double click on  “Micro-
soft Word Picture”. 

Using the menu bar “Drawing” (“View-Toolbars-Drawing”), it’s possible 
to insert, draw and format any type of object. 
• To add text to a drawing, it’s best to use a “Text Box”, which allows you to 

add text to any part of the page.   
• Under “AutoShapes” there are several different categories of geometric shapes 

(lines, arrows, stars, flowcharts, banners and callouts). 
• When a picture is made up of several objects, shapes and text boxes, it’s 

worth grouping them together: from the “Drawing” menu select “Group”: 
in this way the picture will be treated as a single unit. When it becomes 
necessary to work on a single element within the picture you can click on 
the opposite command “Ungroup”. 

• It is also possible to draw freehand, using the option “Freeform” for ob-
jects with line segments or curves. If you want your drawing to look like a 
pen drawing, it’s advisable to use the “Freeform” option. If, however. you 
want a more sophisticated and complex shape, it’s advisable to use the   
“Freehand” option. If you want to draw a curve more precisely and accu-
rately, use the “Curves” option. To modify the shape of a curve or a free-
hand drawing by moving, deleting or adding vertices, select  “Edit Points”. 
It is possible to perfect the aspect of freehand drawings and curves as for 
other shapes. It is, for example, possible to add colour and images, to mod-
ify the line style, and invert or rotate the drawings and curves. It is not, 
however, possible to add text or convert a freehand drawing or curve into 
another shape. 

• It is possible to add a fill effect (it’s best if this is light grey). However, 
always use black for the lines.  
At the end click on “Close Picture” on the “Edit Picture” toolbar. 

 
 
18. Tables 
 

Tables must be numbered progressively in each chapter, starting from 
number 1.  

In both the text and caption, the abbreviation  “tab.” is used. (Example 
caption: Tab. 1 - Table caption). Remember that the table caption goes above the 
table.  

Tables should respect the justification of the text area and so should have a 
maximum width of 11.8cm.  To layout the table automatically in Word, select 
“Insert Table” from the Table menu and specify the number of rows and col-
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umns, keeping “auto” for the column width.  To adapt an existing table to the 
page, use the Word command “AutoFit to Window”. 
• Text character: use 8-9 point  Arial or Helvetica. 
• Borders: from the “Format” menu select “Borders and Shading”. It’s suf-

ficient to leave borders above and below the heading and the border at the 
bottom of the table.   

• Shading: it’s best to avoid shading of any colour inside a table or in any 
part of it, as it noticeably worsens legibility. If necessary, use only shades 
of light grey.     

• Remove borders and shading: once you’ve selected the part of the table 
from which you want to remove the borders and/or shading, select “Borders 
and Shading” from the “Format” menu and then “Borders: None”, “Shading: 
None”. 

• Heading: it’s best to format the font in italics. Remember to leave a border 
above and below it.   

•  Numbers in columns should be aligned.  
 

Tab. 1 - The population of Vietnam: total and divided by sex (in millions)  

Year Population Male Female 
1975 48,0   
1976  23,6 25,6 
1980 53,6 26,0 27,6 
1985 59,8 29,3 30,6 
1990 65,8 32,1 33,7 
1995 71,4 34,8 36,6 
1999 76,3 37,5 38,8 

Source: General Statistical Office, Statistical Yearbook, New York, 2000, p. 347. 

 
 

19. Mathematical formulae 
 
 To create or modify equations, it’s necessary to have the Equation Editor 
programme. 
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And at the end … an extra check  
 
 Once you’ve finished typing your work and before starting on the layout, 
we recommend that you do a spell check and carry out these automatic 
searches. 
 
replace specific Replace with 
double space  single space 

'  ’
’”  ’“
space,  , (no space) 

space.  . (no space) 

space;  ; (no space) 

space:  : (no space) 

space!  ! (no space) 

space?  ? (no space) 

space)  ) (no space) 

(space  ( (no space) 

space-space  space–space 

ecc.  etc. 

space…  … (no space) 

   

   

 
 


